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Welcome ! 
 

Thank You for purchasing EzCoin. Welcome to the age of computerized 

numismatics. Should you have any suggestions, questions, or comments 

please write to us at the address on the front of this package. If you have any 

requests for enhancements that would be nice to have.., please let us know 

and we will try to incorporate any useful ideas into future releases. That's how 

EzCoin has grown to be the mature product that it is. 

If you like EzCoin, please tell your friends about us. Dealer inquiries are 

welcome. If you find any errors or omissions in the documentation, please let 

us know. We're here to help. 

There are many new features in this release of EzCoin. For those of 

you who are upgrading from a previous version, please read this 

quick start guide.  

Please note our E-mail address is mariost@shaw.ca or staff@ezstamp.com 

It is the fastest and easiest way to get help if you need it (other than Reading 

the Manual). Our web site is located at www.stamptools.com or 

www.ezstamp.com and you can also call us at (705) 254-6201 

 

 

 

 

 

  EzCoin For Windows is owned by SoftPro 2001.  

Unauthorized Use or Duplication by any means is Prohibited by Law.  

© 2019 SoftPro 2001. All Rights Reserved 

http://www.stamptools.com/
http://www.ezstamp.com/
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EzCoin Quick Start Guide 

 
You should read the Tips of the Day in EzCoin. They provide very useful 

information for new users. They are available from the Help menu in EzCoin. 
We have also appended them to the end of this document. 

We are continuing to add useful tips here on our website. 
www.pcvu.com/ezcoin/QT/QT0001.html  . These pages will be revised 
and updated over time 
 
Please refer to the following screen shot for reference to the EzCoin Main 
Screen. Pay particular attention to the five numbered areas on the screen.  

 
 
1) Tool Bar: This is where most of the navigation and other controls are 
located. Blue arrows navigate through the SUPPLIED databases, Green 
arrows navigate through your inventoried items.  
 
2) Status Bar: This is where helpful hints appear when you hover over any 
icon. Bottom Left corner of Status Bar will always have an icon to indicate the 
status of the current record ( inventoried, supplied, custom etc ... )  
 

http://www.pcvu.com/ezcoin/QT/QT0001.html
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3) Grades Area: This is where the bulk of the data entry occurs. Just select 
the appropriate rows & click on the GREEN $+ to enter or the RED $- to 
remove a grade entry.  

RIGHT clicking on any icon or label on the main screen will pop up specific 
help for that item. 

 
4) Tabbed Spreadsheet Data Grids: This is where Purchase & Sold details 
are entered. PWL & PSL ( Priority Want & Sell list details are shown here and 
any Custom fields you create will be shown in the Custom Tab. Click any tab 
to show the grid view for the respective information type. The fields which 
appear in the grid view for the Grades tab can be reordered or removed from 
the grid altogether using the Field Settings for Grade Data menu option.  
 

5) Coin Details: This area of the main application window contains the basic 
coin details information. The image preview area and the coin 
details/comments panes share the same horizontal band of the main window. 
You can drag the vertical separator between these two areas to reallocate 
space between them. Every coin record is identified by 5 key attributes:  
Denomination, Year, Type/Reign, Variety, & Mint Mark  
RIGHT clicking on any icon or label on the main screen will pop up specific 
help for that item. 
 
Entering or Retrieving a Coin Record 

A unique coin record is identified by 5 key attributes: Denomination , Year, 
Type/Reign, Variety & Mint Mark  
To search for any coin record, press ENTER while positioning in any of the 5 
key fields. 
If more than one matching coin is found based on the combination of the 5 
fields, a report view will be displayed with all matching records. If the coin is 
already inventoried, the record will be retrieved. If not, pre-supplied coin info 
will be retrieved and you can inventory the item. If the coin record can’t be 
found based on the 5 key fields #, you will be asked to inventory the record 
as a custom variety. If a coin is already inventoried, a GREEN checkmark is 
displayed as a visual cue. A RED checkmark indicates that a CUSTOM catalog 

number was inventoried. A VIOLET checkmark indicates that this is a 
duplicated record. 
 
Alternate Catalog #’s 
EzCoin includes cross a reference to the PCGS Numbers (with permission) to 
allow retrieval of US coins. If you have imported a cross reference file (See  
File Menu, Export/Import, Import Alternate Catalogue ID’s), you can enter or 
retrieve coin information by the Alt Cat #. Simply enter the number and hit 
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the ENTER or TAB key on your keyboard. There are up to 4 Alt Cat #’s 
available to you and each can be renamed to suit your specific needs. Each ID 
can be relabeled for ALL countries or just the specific country you have open. 

Left Clicking on the Label will allow you to switch Cat #’s and rename these 
fields. 
 
Market/Supplied Values 
This is the EzCoin market value for each coin, depending on the grade you 
have selected. You may override this value if you choose to. Also note that 
you can set a Price Lock on any coin so that Price Updates will never alter 
these values! (See price lock icon at the bottom left portions of the Status 
Bar. This is a pre-supplied field 
 

Save Your Current Coin Record    
To SAVE the current record, simply Left Click on the Blue Checkmark Icon on 
the Tool Bar or just above the status bar. To Delete a record, Left Click on the 
Red X. Deleting a record removes it from your inventory, not from the 
supplied database. 
 

Adding Coin Grade Details/Data 
Use this icon to commit the data you have entered for the selected grade (i.e. 
qty, your value, dates, comments etc.). This does NOT save the record to disk  
yet. It just accepts the entries for that selected grade. You can select multiple 
grades at a time and commit them at the same time. To actually SAVE the 
record to disk, you must left click on the Save Record Icon (blue checkmark)  
OR Right Click in the Grades Area and  select ADD and SAVE from the Pop Up 
Menu. 
A general preferences option can be enabled to allow you to auto add grades 
when you click the blue check icon to save the record. It performs the 
function of Blue Check + this button on one step. 
  

Adding Coins with Bullion Values 

There are times when the precious metal content of a coin (gold, silver, 
platinum or palladium) is valued more than the market value of a coin. EzCoin 
AUTOMATICALLY show you when this occurs so that you can inventory the 
coins as a bullion entry. For example, if a pure gold coin (1/10th of an oz) in 
the grade of F-4 is listed with a market value of $50, but the bullion value is 
calculated at $130, then EzCoin will display for you the Bullion value & let you 
inventory it as a bullion coin. These calculations are automatic & based on the 
current market values of the precious metals. 
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In other words, if the coin contains a precious metal composition, and also a 
valid weight, EzCoin will calculate the bullion value based on the current 
precious metal price values assigned to the country and display it in the 

bullion field.  
 

Removing Coin Grade Details/Data 
Use this icon to remove the selected grades from your data (i.e. qty, your 
value). To CLEAR ALL fields for the Grades, hold down Ctrl and Left Click on 
the $- .This does NOT remove the record from your inventory, just the  
selected grades. To remove the entire record/coin from your inventory, you 
must click on the RED X on the Tool bar. You can select multiple grades at a 
time and deselect them at the same time. You may also deselect grades by 
selecting grades and then RIGHT clicking in the grades area and click Remove 

Selected from the popup Menu. 
 

Edit/Select Coin Grade Details/Data 
Use this icon to bring up the single quick grade edit window. In this window 
you can edit any of the dates, prices and comments. Compare this to the 
Grades quick Editor icon which allows for editing multiple grades and the 
associated details at the same time. 
 

Edit Multiple Coin Grade Details/Data 
Use this icon to allow editing of multiple grades in a grid view editor. You can 
make changes to the data for any of the grades listed. You can clear all fields. 
Any changes you make can be undone within the CURRENT quick edit session. 
Once the window closes, changes cannot be undone. This provides a quick 
way to make multiple changes to multiple grades in one convenient window. 
An option available in Options, Preferences allows you to auto-save the coin 
record. Once you save the data in the Quick Edit window (click on the Apply 
Changes Icon) so that you do not have to also click on the Blue checkmark 
(Save Record Icon) in the main screen to save the coin record. 
 

 Deselect Grade 
If you have selected a grade or multiple grades, you can click on the Grades 
Deselect Icon to deselect the grade. This does NOT clear any data, but just 
deselects the grades. 
 

Navigating Through Supplied Coin Records 
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To Navigate through the supplied database, simply LEFT click on the BLUE 
navigation arrows on the Tool Bar to advance forwards or backwards one 
record. 

 
Ctrl+Left Arrow will move to the FIRST Entry in the database while Ctrl+Right 
Arrow moves to the LAST entry for the navigation method used. 
 
The blue arrows include any pre-supplied coin records which are either part of 
your inventory or have yet to be inventoried. For custom countries without 
pre-supplied data, the blue arrows have the same functionality as the green 
arrows. 
The default stepping method is by Denomination order. 
 

Navigation Arrow Step Method 
Use this icon to change the stepping method used by the Blue arrows. The 
default is to step through the data by Denomination order. You can change it 
to step by Year or by UID value (SoftPro’s unique ID value is assigned for all 
coin records for pre-supplied coin records. It's an optional field for any custom 
country files or custom variety coin records.) 

Navigating Through Your INVENTORIED Coins 
To Navigate through items you have Inventoried, simply LEFT click on the 
GREEN navigation arrows on the Tool Bar. This will advance one record 

forwards or backwards. 
 
Ctrl+Left Arrow moves to the FIRST Entry in your inventory while Ctrl+Right 
Arrow moves to the LAST entry. 
 

Navigating Through Navigation Lists 
Navigation lists are sets of coin records which you can create from most 
Search and Report options available in EzCoin. Once a navigation list is 
created, you can use the violet arrows to step backward and forward through 
the list. 

 
Ctrl+Left arrow will move to the first record in the list. Ctrl+Right arrow will 
move to the last record in the list. 
 
The current and total number of coins in a navigation list will appear in the 
bottom status bar of the EzCoin window. 
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Remove/Delete a Coin Record from Your Inventory 
This icon will delete the current record from your inventory. It does NOT 
remove the record from the supplied data. You will ALWAYS be prompted to 
confirm that you want to permanently delete the entry from your inventory. 
 

Clear Screen 
Left click on this icon to clear the data entry fields for this record. LEFT 
clicking on an inventoried supplied record will clear all inventoried grades and 
any non supplied data fields. To clear the screen of ALL data fields, use 
Ctrl+Left click on the eraser icon. For custom records that you have created, 
this will also clear any image link you have to this record. 
 

Duplicate an Inventoried Coin Record 
This is a very powerful feature. By design, EzCoin consolidates any coin on 
one screen. It allows you to track multiple copies & varieties on the one main 
screen. EzCoin allows you to have a duplicate record of any coin record. 
 
Say you have 10 copies of a coin but one of them is special in some way 
(toned, cleaned ...). You could enter the 9 copies in one record and then 
create a duplicate record for the special one. This has many benefits. It will 
also allow you to individually track any coin if desired. You can duplicate a 
record by clicking on the Duplicate Icon in the Tool Bar or go to the Edit Menu 

and Select Duplicate. To duplicate a record, it MUST already be inventoried. 
Once a record has been duplicated, the STATUS BAR will show you the 
number of duplicate records for this coin record. All duplicated records will 
show a Purple DD icon in the Lower Left portion of the Status Bar. 
 

Priority Want List (PWL) 
Priority Want and Sell lists give you a unique way of entering items into a 
want or sell list. By default, any item that is inventoried is automatically 
removed from the regular want list. There may be times when you want to 

have a coin in your want list even though you already have a copy of that 
coin.  
 
The PWL icon on the tool bar allows you to add items to a separate want list 
(apart from the regular want list). You can add and remove items from the 
PWL at any time by using the Ctrl+Left Click on the PWL icon. If you have a 
grade selected when you click on the PWL icon, a special W+ icon will be 
placed next to the grades you had selected in the Grades area.  
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When an item is in the PWL, the PWL icon will turn GREEN. Similarly, the 
Priority Sell List (PSL) works the same way. PSL and PWL reports allow you to 

easily track what you have placed in these lists. 
 
Priority Sell List (PSL) 
Priority Want and Sell lists give you a unique way of entering items into a 
want or sell list. You can add and remove items from the PSL at any time by 
using the Ctrl+Left Click on the PSL icon. If you have a grade selected when 
you click on the PSL icon, a special S+ icon will be placed next to the grades 
you had selected in the Grades area. When an item is in the PSL, the PSL icon 
will turn GREEN. Similarly, the Priority Want List (PWL) works the same way. 
PSL and PWL reports allow you to easily track what you have placed in these 

lists. 
 

EzBrowser View of EzCoin Data 
A new way to search & view the data in EzCoin. By LEFT clicking on this icon 
or hit Ctrl+F, a new viewer will appear with all the SUPPLIED data. You can 
select any item in the list by double clicking on it. Double clicking on an item 
will display it in the main screen. F12 will toggle the image view on or off. To 
see only your inventoried items in this browser, select the appropriate option 
on the initial EzBrowse dialog screen. 
 

Recall the Last Search Performed 
This icon will recall the last search you performed with all the parameters and 
selections you used before. This will save you time when you frequently run 
the same searches. 
 
Recall the Last Report Performed 
This icon will recall the last Report you performed with all the parameters and 
selections you used before. This will save you time when you frequently run 
the same reports 
 

Quick Stats Reports 
This icon will recall the last Quickstats Report you performed with all the 
parameters and selections you used before. This will save you time when you 
frequently run the same Qstats report. Qstats are the most frequently run 
reports in EzCoin 
 

Custom Fields Entry 
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This icon will display the Custom Fields Entry screen. If you have defined 
custom fields (Utility, Custom Fields Editor), this floating window will allow  
you to see and edit the data in the Custom Fields. Saving a Custom Field 

entry will ALSO save the record on the main screen to your inventory! EzCoin 
allows for as many custom fields as you may need. 
 

Edit/Change Image Links 
This icon allows you to Edit and change image links for any record. You can 
paste in images from the clipboard or link to images you have scanned to files 
on your hard drive. Images can be of any format (bmp, jpg, gif etc). 
These paths to the images to be used can be set in the EzCoin general 
Preferences. 

Thumbnail Viewer (TV) 
Clicking on the Thumbnail Viewer (TV) Icon will populate the viewer with 
thumbnail-sized coin images. The viewer can accommodate up to 196 coins 
(14 rows by 14 columns). Change the 5 key fields and hit tab and the viewer 
will refresh. Left click on any image in the viewer to show it in the main 
screen. Double Click on any image and it will instantly retrieve that coin. Click 
on the arrows in the TV panel below the images to navigate the database. 
Alt+F12 will activate the viewer by Alt Cat # if you have built a cross 
reference file. F12 will activate the viewer by Denomination order. Ctrl+F12 
will activate the viewer by Year of issue order. The viewer can also be resized 
to make the thumbnails larger if you have a large screen by drag sizing the 
window. Preference settings allow you to control what the viewer looks like 
and what data it displays. You can resize the TV by drag sizing it from one of 
the corners. (It will retain the last resized dimensions) 
 

Special Coin Information 
EzCoin provides detailed images to help you determine varieties and errors. 
Click on the Special Information Icon on the Tool Bar (Si) to bring up special 
information. If no Special Info is available, the icon remains greyed out. 
 

Image Compare – Second Image Viewer 
Clicking on this icon will bring up the currently displayed coin into a second 
viewer. Thus, you can have images of 2 different coins on the screen at the 
same time to allow easy image comparison (i.e. design changes). Great for 
comparing varieties. You can also swap the coin record associated to the 
image in the compare window with the one on the main screen. 
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Special Characters (Fractions & Pound Symbols) 
This icon will allow you to enter special characters into the data fields, such as 
¼, ½, ¾, and £. 

 
More Images 
This icon will appear when there is more than 1 SUPPLIED image available. To 
see the other SUPPLIED images, simply click and select from the available 
images in the drop down list. 
 

Country Data Information 
This icon will open a window which will display a summary of properties and 
statistics for the opened country file. Data such as total # of coins 

inventoried, total value and other important information is available. 
 
Snapshot Viewer 
This is a great new feature only available in EzCoin. With our new EzCoin 
SnapViewer, you can save ANY EzCoin report in a special format which can be 
read by EzCoin AND by anyone else even if they do not own EzCoin. This will 
allow you to send want lists, inventory reports etc. to dealers, friends,  
fellow coin club members and anyone else. All that is required by the person 
you are emailing/sending the report to is to download a very small file called 
snapview.exe from our website. They simply place the file (an exe file) into a 
folder on their hard drive (ie. C:\SnapViewer) and then they place the files 
you send them in that folder. Then simply run SnapViewer and open the *.snc 
file you sent to them & they will see the identical report that you generated in 
EzCoin. The Snapview utility can be downloaded from our website from FREE 
 
http://www.pcvu.com/ezcoin/QT/SnapView/EzcSnapSetup.exe   

http://www.pcvu.com/ezcoin/QT/SnapView/EzcSnapSetup.exe
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EzCoin Preferences Section 
 

EzCoin has many preferences & settings (available from the Options menu) 

that can be customized to suit your specific needs. If you RIGHT click on any 
Label in the preferences tabs, appropriate help and descriptions of each 
settings purpose is described. For most users, the default settings will be the 
norm, but there are MANY options that will make your use of EzCoin much 
more personalized to the way you work. We suggest that you explore these 
options to make full use of EzCoin and all its powerful capabilities.  
 
  



EzCoin v2.0 Quick Start Guide 

EzCoin Quick Start Guide v2.0 [© SoftPro 2001 . All Rights Reserved ]  Page 14 
 

Tips of the Day 
 

WELCOME:  

Thank You for your purchase. EzCoin has all the features a coin collector could 
want to track & inventory their collection. The following Tips & FAQ will assist 
you in getting the most out of EzCoin and all its features. Whether you are a 
Novice or Experienced user, you will find these tips helpful & will make your 
use of EzCoin more efficient. 
 
FREE PROGRAM UPDATES:  
EzCoin provides FREE downloadable updates right from within the program. 
Go to Help, Check For Free Updates. This is used for bug fixes, updates & 
changes to the program itself, as well as updates to required files. This is NOT 

the annual updates for the databases, prices & images. Those are purchased 
annually from SoftPro. You should check on a regular basis to ensure you 
have the most up to date version of the program. 
 
RIGHT CLICK HELP: 
Right click on almost any icon or Label on the main EzCoin screen & a context 
sensitive help dialogue will appear. Try Right Clicking on the Shopping Cart as 
an example. This is useful for new users & beginning collectors. 
 
RIGHT CLICK ON GRIDS:  
Right clicking on any grid (Grades & Prices area or the Report Viewer) will 
reveal a context sensitive Pop Up selection menu with many different options 
that are relevant to that grid. 
 
DEALER / AUCTIONEERS LISTING: EzCoin provides links to professional 
coin dealers as well as experienced auctioneers who hold extensive auctions 
year round. Whether you are buying or selling, or looking for supplies, you 
owe it to yourself to browse through our dealer listings by going to Help, 
Dealers, Suppliers & Auctioneers. Tell them Marios sent you ! 
 
STATUS BAR HELP:  

The STATUS BAR (Strip at the bottom of the Screen in EzCoin) will display, 
short, relevant tips/help for almost any Icon on the Main EzCoin screen as 
well as most if not all other screens in EzCoin. The BOTTOM LEFT corner of 
the STATUS BAR will Display different ICONS depending on what the program 
is doing. Many Visually Helpful Icons will appear here to Visually Indicate to 
you different things such as when Duplicate records exist, whether an item is 
inventoried, a custom record/variety has been entered …. You will be able to 
use this area of the Status Bar as a quick indicator on the state of any given 
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record. Pay close attention to the Status Bar as it is used extensively in 
EzCoin. 
 

IMAGE RETRIEVAL & DISPLAY - NEW USERS:  
To enter or retrieve a coin, simply enter any of the 5 key fields 
(Denomination, Year, Type/Reign, Variety or Mint Mark) & hit the ENTER or 
TAB key on your keyboard. Do not click on the Save Icon (Blue Checkmark) 
unless you want to inventory the coin. The ENTER or TAB key will retrieve the 
coin and relevant information (pricing, descriptions etc). EzCoin will allow you 
to inventory a coin with no data entered, so do not click on Save Record 
unless you want to save the coin into your inventory 
 
NAVIGATING Through the DATABASES:  

To Navigate through the supplied databases, simply LEFT click on the BLUE 
navigation arrows on the Tool Bar. Ctrl+Left Arrow goes to the FIRST Entry 
while Ctrl+Right Arrow goes to the LAST entry for the navigation method 
used. To navigate through Inventoried items only, use the GREEN arrows on 
the Tool Bar. The PURPLE arrows are used to Navigate through special lists 
that you build. Keyboard shortcuts for navigation are as follows:  
Ctrl+Up/Down Arrows = Next / Previous Supplied Record, Ctrl+Left/Right 
Arrows = Next / Previous Inventoried Record 
 
SAVING & DELETING RECORDS:  
To save the current record, simply Left Click on the Blue Checkmark Icon on 
the Tool Bar. To Delete a record, Left Click on the Red X. Deleting a record 
removes it from your inventory, not from the supplied databases. 
 
BULLION VALUES:  
If any coin contains a precious metal composition(Gold, Silver, Platinum or 
Palladium), and also a valid weight, EzCoin will calculate the bullion value 
based on the current precious metal price values assign to the country and 
display it in this field. If the current market value for any grade is LESS than 
the Bullion value, the bullion value will be automatically highlighted for you so 
as to enter it as a Bullion Coin. The yellow $+ button will add the selected 

grades as bullion valued items. The net value will now be based on the bullion 
value of the coin, not the market value of the grade. 
 
LEGEND of TERMS USED in EZCOIN: Most of the commonly used 
numismatic terms used in EzCoin are described on our web pages. Click the 
More Help button to visit this page. 
URL::http://www.EzCoin.com/EzCoin/QT/QT0002.html 
 

file:///H:/EzCOIN_2/Documents/Marios_Modified/:http:/www.EzCoin.com/EzCoin/QT/QT0002.html


EzCoin v2.0 Quick Start Guide 

EzCoin Quick Start Guide v2.0 [© SoftPro 2001 . All Rights Reserved ]  Page 16 
 

ADDING VARIETIES/CHANGING ENTRIES:  
Adding new or unlisted varieties is very easy in EzCoin. Simply enter any new 
combination of the 5 key fields (Denomination, Year, Type/Reign, Variety or 

Mint Mark) that is not already in the supplied database & click Save when 
prompted. You can enter the new variety as a Main # or as a sub variety. You 
can enter as little or as much information about the coin as you want to. If 
the screen already had data from a supplied Coin entry, the data will be 
preserved with the new variety. You can edit & change the appropriate 
information for the variety.***IMPORTANT: The UID must be UNIQUE for 
every coin entry so you will need to erase the existing one or create a new 
one ***.To link to a different image, just click on the link icon (looks like a 
chain link). We have also added a report that will list all items that you added 
that were not in the supplied database or any supplied records that you 

modified. The report can be accessed via the Reports, Inventory Reports, 
Customized Entries/Records Repor 
 
PRICING/SUPPLIED DATA UPDATES: 
EzCoin has the ability to track any price changes you make. This means that if 
you make any changes to our prices (the prices supplied by EzCoin), next 
years pricing update will not overwrite those entries unless you choose to 
have them overwritten. Also, if you override EzCoin prices, you can revert 
them back to supplied values at any time. Price Locks are also available so 
that any records that have a price Lock applied, will NOT be overridden by 
updates until the price locks are removed. 
 
MULTIPLE IMAGES: 
EzCoin allows you to have four images for every coin you enter (two obverse 
& two reverse). Any two can be viewed at the same time. You can alternate 
between the Alternate & Supplied images by clicking on the Alternate Image 
Icon in the tool bar near the top right corner of the tool bar. 
 
EZBROWSE VIEWER: 
A new way to search & view the data in EzCoin. Simply hit Ctrl+F & a new 
viewer will appear. You can select any item in the list by double clicking on it. 

Double clicking on an item will display it in the main screen. F12 will toggle 
the image view on or off 
 
PRIORITY WANT & SELL LISTS / REPORTS: 
Priority Want & Sell lists give you a unique way of entering items into a want 
list. By default, any item that is inventoried is automatically removed from the 
regular want list. There may be times when you want to have a coin in your 
want list even though you already have a copy of that coin. The PWL icon on 
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the tool bar allows you to create a separate want list from the regular want 
list. You can add & remove items from the PWL at any time. Similarly, the 
Priority Sell List (PSL) works the same way. PSL & PWL reports allow you to 

easily track what you have placed in these lists. 
 
FILTERED COIN ENTRIES/SEARCHES: 
Using the INVERTED triangle icon (first one in the toolbar) will allow you to 
filter your coin entry searches so that ONLY the relevant coin types are 
displayed. For example, if you want to find criteria for 1 cent coins, all other 
criteria that are NOT relevant to 1 cent coins are remove from the displayed 
list making it easier to find your coins 
 
MERGE TWO FILES: 

EzCoin allows MERGING of two files into one. This allows you to merge the 
contents of 2 files together. Helpful when you have 2 computers or two people 
inventorying the same collection. You can also have 2 people working on 
inventorying a collection. One person does pre-1950 coins, the other does the 
post 1950 issues. When you are done, you can merge the 2 files into one to 
have a complete inventory of the collection. 
 
eLook / (eBay & BidStart WebSearch): 
Use this handy tool to quickly locate any coin on the internet. Just hit Ctrl+E 
while running EzCoin. eLook will search eBay (the most popular coin auction 
site) to quickly locate the coin. Our highly selective search filters will only 
show you the relevant matches. 
 
RAPID Multi ENTRY (RME): 
The Rapid Entry feature has been greatly enhanced to allow rapid multi entry 
of any field available in EzCoin. You can perform rapid entries by entering a 
range of valid Scott #'s. Go to the Edit Menu & select Rapid Multi Entry. You 
can enter a range of sequential entries all in a matter of seconds. If there are 
entries in the range that you do not want, you can just recall them & then 
delete them from your inventory. Options allow you to Append to existing 
records, Replace existing entries or skip existing entries. 

 
DUPLICATE A COUNTRY: 
This allows the duplication of the currently opened country. Many users use 
this option to easily create a duplicate file for their children, wives or other 
family members to track their personal collections. This is easily accomplished 
(File Menu, Duplicate a Country). This option will set up an empty duplicate 
country file for you to track another collection. 
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DUPLICATE A RECORD:  
This is a very powerful feature. By design, EzCoin consolidates any coin on 
one screen. It allows you to track multiple copies/varieties on the one screen. 

EzCoin allows you to have a duplicate record of any Coin . Say you have 10 
copies of a coin but one of them is special in some way (error, double date 
...). You could enter the 9 copies in one record & then create a duplicate 
record for the special one. This has many benefits. It will also allow you to 
individually track any coin if desired. You can duplicate a record by clicking on 
the Duplicate Icon in the Tool Bar or go to the Edit Menu & Select Duplicate. 
To duplicate a record, it MUST already be inventoried! Once a record has been 
duplicated, the STATUS BAR will show you the number of duplicate records for 
this coin type.  All duplicated records will show a Purple DD icon in the Lower 
Left portion of the Status Bar. 

 
SPECIAL INFORMATION: 
EzCoin provides detailed images to help you determine varieties & errors. 
Click on the Special Information Icon on the Tool Bar (Si) to bring up special 
information. Try the following in the Canada file (10c 1953) or in the USA file, 
try 1c 1969. Many others exist! Use it to your advantage to easily discern 
between varieties! 
 
IMAGE COMPARISON: 
You can have images of 2 different coins #’s on the screen at the same time 
to allow easy image comparison (ie varieties, design changes). Just click on 
the Image Compare icon on the Tool Bar to compare images. Great for 
comparing varieties & design changes. You can also swap images with the one 
on the main screen. 
 
THUMBNAIL VIEWERS: 
Hit F12 or Ctrl or Shift or Alt+F12 to activate the appropriate viewer. This will 
bring up a viewer for up to 196 coins (14 x 14). Select  a coin in the main 
screen & hit tab & the viewer will fill up. Left click on any image in the viewer 
to show it in the main screen. Double Click on any image & it will instantly 
retrieve that coin. Click on the arrows in the panel below the images to 

navigate the database. Alt+F12 will activate the viewer by Alt Cat # if you 
have built a cross reference file. F12 will activate the viewer by Denomination 
Order. Ctrl+F12 will activate the viewer by Year Issued order. The viewer can 
also be resized to make the thumbnails larger if you have a large screen by 
drag sizing the window. 
 
BACKUP & RESTORE: 
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Compressed Backup & Restores are built in to EzCoin. EzCoin has a built in 
ZIP compression routine to safely backup & restore your data as well as 
important EzCoin settings & files. Backups are very easy, and are invaluable 

should your system or hard disk crash. Backup often and keep multiple copies 
of your backups. We recommend at least one back up be on removable media 
such as an external drive of some type (flash drive / memory stick). To 
RESTORE a file in EzCoin, you MUST first close all files by clicking on File, 
Close. The Backup & Restore are accessed via File, Country Datafile Utilities. 
Please note that Backups CANNOT be written to CD/DVD’s directly. Important 
EzCoin backups are made up of 2 files (a *.cfg file & a *.zip file). 
BOTH FILES ARE REQUIRED to restore data. If you are manually 
copying/moving your backups, you MUST be sure to get both the CFG 
& ZIP files together! 

 
REPORTING OPTIONS: 
All reports in EzCoin are first presented on screen & then you can print them if 
you like. Multiple filter methods are presented in all reports to allow you to 
select exactly what you want to report on. Reports in EzCoin are VERY flexible 
and can be presented in many ways (spread sheets, thumbnails). Many 
options are available in the report viewer. You can remove any column from 
any report, you can add columns to supplied reports and create any new 
report. You can preview ALL reports on screen prior to printing them. A very 
handy report is the Grand Totals report which accumulates data for all 
countries where you have inventoried coins. You can sort any report by any 
column by simply left clicking on the column header (label). 
 
CUSTOM REPORTS: 
All reports can be customized. You can delete any column in any report that 
you do not want to see. You can also sort any report on ANY column. This 
allows you to easily see what the most expensive coin is, or which coin you 
have the most of as an example. You can also print only portions of a report 
once it has been generated. You can create a copy of any supplied report & 
modify it to suit your needs. Brand new reports can be easily created from the 
Report Profile editor. 

 
POWER SEARCH: 
The Power Search is available from the Search Menu or Ctrl+Q . This search 
allows searching of  ALL fields & records in the database. You can use the 
following operators to search :  = , < , > , <> , <= , >= , CONTAINS , DOES 
NOT CONTAIN . Think of the power you now have. You can search for multiple 
criteria for any Coin ! The possibilities are endless. Once the search is 
performed, you can show the results in a Report Viewer spreadsheet or view 
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them in the Thumbnail Viewer. The Power Search thumbnail viewer works the 
same as the other thumbnail viewers. Power searches can be used on 
Supplied Data, Inventoried data or both! We URGE you to use this POWERFUL 

new feature 
 
MY IMAGES WON’T SHOW UP ANYMORE! 
This can happen if you do not have the correct EzCoin CD inserted. This can 
also happen if your CD ROM drive letter has changed. You can set your CD 
ROM drive letter via Options, Preferences. If you do not know what letter is 
assigned to your CD ROM, the insert the EzCoin CD & go to MY COMPUTER to 
see what it is!We suggest that images be copied to your hard drive via 
the Utility, Image File Copy function. This will greatly enhance speed 
& will protect your CD’s from scratches & damage. 

 
CUT & PASTE IMAGES: 
You can now easily cut & paste images into EzCoin from the clipboard. Simply 
put the image into the Windows Clipboard then in EzCoin click on the Image 
Link Icon. It's that simple! 
 
SCREEN RESIZE: 
If you do not want EzCoin to run as a full screen application, simply resize the 
program window to your liking. The setting is automatically saved so each 
time your run EzCoin the new window size will be remembered. EzCoin will 
also recall the program window location on your desktop as well as other 
screen settings within EzCoin. Very useful if you want to have 2 programs 
visible at the same time. 
 
COPY IMAGES TO DISK: 
EzCoin has a built in utility to COPY the images from the CD to your hard disk 
(Utility Menu, Image Copy) to increase speed and to remedy the issue of 
having to swap CD's all the time if you purchased more than one of our CD's. 
You will still be bound by the copyright & licensing restrictions of the images 
we supply. ALL EzCoin IMAGES ARE INTERNALLY MARKED.  YOU CANNOT SEE 
IT, BUT THE MARK IS THERE. WE DO THIS TO PROTECT OUR HARD WORK 

FROM OTHER DEVELOPERS WHO HAVE ATTEMPTED TO USE OUR IMAGES 
WITHOUT A LICENSE. ALL VIOLATIONS WILL BE STRICTRLY ENFORCED. NO 
EXCEPTIONS. 
 
EZIMAGE: 
Our new program to help with your image processing. EzImage can 
automatically separate images, auto-rotate & auto crop. FREE DEMO from 
http://www.pcvu.com/ezimage 

http://www.pcvu.com/ezimage
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EZSTAMP: 
Our Stamp Inventory Software that is unsurpassed in ease of use and 

functionality. Get your FREE DEMO from our website at  www.ezstamp.com . 
 
COINS FOR SALE: 
SoftPro purchases many Canadian & US coins each year. We resell these coins 
at 10% below our cost. If you wish to order any particular coin, just visit our 
website or give us a call at 705-254-6201. We also have better singles & sets 
available on our site at http://www.EzCoin.com/EzCoin/cfs.html 
  

http://www.ezcoin.com/EzCoin/cfs.html
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Importing Your Data From A Prior Version of EzCoin 
 

Please follow these steps carefully to import your data from EzCoin v1.02 

(2014.08.01)  
 
1. First, you must install & activate the new EzCoin v2.0 on your PC. EzCoin 

v2.0 will run on 32 & 64 bit versions of XP, Vista & Win 7, Win 8.1 
 

2. Next, you must export your data from EzCoin v101 in this way: 
You must download the latest version of EzCoin v1.02 by starting EzCoin 
v1.0, go to the help Menu, & select Check For Updates. Close EzCoin v1. 
Once downloaded, go to Start, All Programs, SoftPro 2010, EzCoin, 
Application Updates, Select the EZC_20140801.upd and apply it. Please 

refer to the screens shots below to guide you. 

     
 

 

1 

2 
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3. Once the update has been applied, Open a country file that you want to 

export the data for then select File, Export for EzCoin v2.0 & export the 

data. The Exported files are ALWAYS placed in the ExpEz2 folder (if it does 
not exist, the system will create it for you). 
ie.    C:\SoftPro2010\EzCoin\ExpEz2   
 
Exported files will have an extension of *.ez2  . You will use this file to 
import the data into EzCoin v2.0. Type in a file name  
ie: 2014-12-06EzCoin-CDN-v1-to-v2. 
 
For each Country that you have data entered into that you wish to import 
into EzCoin v2.0, you MUST first EXPORT the data in EzCoin v1.0 

 

 
 
 

If EzCoin (v1.0) is not on the same computer, then you will have to migrate 
the *.ez2 file onto the new PC (you can copy the file(s) on to a flash 
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drive/memory stick or any other way you have of getting the exported files 
onto the new PC) 

 

4. Now start EzCoin v2.0 to import the data. 
Select the File Menu in EzCoin v2, then select ‘Export & Import’, then ‘Import 

From Prior EzCoin’ to populate the data into an existing country file.  

 

 

 

 

 

Use the Open File button to browse for a version 1 export file (*.ez2). 

Search for the Custom Image File Location ie: C:\SoftPro2010\EzCoin\Canada. 

If the archive contents are validated without error, the following information is 

displayed at the top: 
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         Name of the country of origin 

         The country file description 

         The original EzCoin version 1 data file the export was created from 

         The number of inventoried coin records 

Below this information are some import options. 

Location Copy EzCoin version 2 contains location fields for both the 

primary coin record and for individual grades within the 

same coin record. When importing the location field, you 

will need to indicate how this field is copied. 

Link Pre-Supplied If the country of origin can be referenced to any installed 

pre-supplied country in EzCoin version 2, then entries will 

appear in the pre-supplied dropdown list and the pre-

supplied checkbox option will be enabled and checked by 

default. Uncheck this option to create a custom country. If 

no pre-supplied data can be matched based on country 

name, you will not have any linking option. 

Copy Custom 

Images 

Check this option to copy all custom images from version 1 

of EzCoin to version 2. Note that this feature is just a 

simple shortcut to physically make copies of all image files 
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from their version 1 location for version 2. You will need to 

set the path for version 1 images if you choose this option. 

 

Please read the section at the end of this help topic 

regarding image links between version 1 and 2 of EzCoin. 

Market Value 

Assignment 

Unlike EzCoin version 1, you are permitted to define or 

change a market value for any grade, with the 

understanding that any pre-supplied value from SoftPro 

could potentially replace it on a data patch. 

 

Since many grades may lack pre-supplied values, the 

market value should be populated whenever possible, as 

opposed to strictly using the user value field. When you 

check this option, any user value will copy over to the 

market value for any coin grade where a market value 

doesn't currently exist. 

New File Name The file name will be set based on the version 1 file name 

and/or the pre-supplied country file source. See the notes 

below on importing into an existing file versus creating a 

new file. 

New Description If you want to customize/change the description for this 

country, enter a new value in this field. 

 

(a) New Versus Existing Country 

If you import into an existing version 2 country file, all customizations and inventoried information 

are discarded.  

If you choose to install into a new country file, with the pre-supplied link option, all pre-supplied 

version 2 information will be merged with your inventoried coin data into the new file. 

Note that you may not import pre-supplied version 1 coin data into version 2. EzCoin version 1 pre-

supplied information is not compatible with version 2. If you need the pre-supplied version 2 data 

for a country, you will need to purchase the country file data with EzCoin. 

(b) Adding Version 1 Inventoried Data to Version 2 Data 

If you have inventoried coin records to the target version 2 country file and wish to add version 1 

data on top of this, you can't do this directly through the import utility. You will need to import 

version 1 data into a new country, and then use the country file merge utility to combine the 2 files 

together. 

Pre-Supplied Image Link Restoration 

By default, image links (the file name references to images stored in a pre-supplied library from 

SoftPro or image files stored on your PC) for pre-supplied coin records will be set to EzCoin Version 

2 file names. 
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This may produce unwanted results if you've overridden the images with your own custom 

versions. The ideal way to override pre-supplied images is to put files with identical names into the 

Images subfolder in EzCoin using the Image Link utility. EzCoin will always take a custom image file 

with the same name as a pre-supplied image. 

However, if you used a different file name in version 1 of EzCoin, you will lose the custom link 

when using the import utility. For this reason, a separate Image Link Restoration option is provided 

(File menu, Export and Import, Restore Image Links from Version 1). 

Make sure the country file is opened for image link restoration. Choose the menu option to see the 

following screen. 

 

Use the Browse button to select a version 1 backup file (.EZ2 extension). 

Click on Restore to restore all custom image links for pre-supplied coin records. Note that custom 

variety coin records will already have the correct image links and will be unaffected. 

EzCoin will generate a log file of any restored links. 

Note that you should have chosen the copy image files from the EzCoin Version 1 Import Utility, so 

that the actual image files will be located in the correct folder. 
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Installing, Updating & Uninstalling 
 
FIRST TIME INSTALLATIONS: 

The first installation of any v8.0 CD/download is fairly straightforward. 
Once the EzSetup.exe is run, you will see several screens as shown below. 
Not all screens will appear the VERY FIRST time you run an install. The very 
first install on your PC will always be a Full Install of the package. Subsequent 
installations & re-installations will offer you 4 types of installations. 
*** It is critical that you select the correct installation type. Choosing the 
wrong type can wipe out your data. Before you do any kind of installation, be 
certain that you have backed up your data to a location other than where the 
program is installed. We recommend that you keep a backup of your data on 
external media such as flash drives/memory sticks or external hard drives. 

The first screen will always be the License Agreement (EULA). You must 
accept the terms of the license to proceed. 
 
 

Next, you will see a screen where you can select Where to install EzCoin to. 
We recommend that you accept the default location structure  
ie.   <DriveLetter>\SoftPro2010\EzCoin2   
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You can safely specify any hard drive letter that you like, but leave the default 
location of ..\SoftPro2010\EzCoin2 as is. If you alter this default installation 
path, the next time you install new CD’s or updates, it will be up to you to 
install to the correct location. By using the default location of ..\SoftPro2010\ 
EzCoin2, the installer will automatically install to the correct location. 
 There is a checkbox option named Install Coin Images with 
Countries. Each pre-supplied country file will contain an image file library 
(with a file extension of .IMG) which contains all of the pre-supplied coin 
images. This file can be copied to the EzCoin installation path (and will be 
stored in the Images subfolder) by checking this option. As EzCoin images are 
represented as JPEG images, the amount of extra storage space is minimal - 
it's recommended to keep this option checked, as it will improve performance 
when retrieving image information. 
 The next step will allow you to choose which country databases to install 
if you have purchased a CD with multiple countries. Simply check or uncheck  
the selections to suit your collecting needs. 
 
If the installer detects a version of EzCoin is already installed on your system, 
you will see this screen below appear. 
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IT IS CRITICAL THAT YOU SELECT THE CORRECT OPTION. FAILURE TO DO SO 
CAN WIPE OUT ALL YOUR DATA. MAKE SURE YOU HAVE BACKUPS BEFORE 
YOU PROCEED WITH UPDATE INSTALLATIONS. 

 

 
Each of the 4 options is explained below 

1) Install new countries, update application files and update existing 
countries as needed. 
This option will install new countries and update existing countries in 
EzCoin. It can also update the program itself (the exe) as well as other 
EzCoin support files. It will NOT delete any databases or settings in your 
existing installation. This is the default setting for all updates you 
purchase. 

2) Perform a Clean Installation and preserve existing country files 

This option will replace the EzCoin program and its support files. It is 
similar to a FULL NEW install except that it will NOT delete any of your 
databases or inventory data. It WILL restore ALL EzCoin settings back to 
default (ie. Preferences will be set to default, reports will be replaced 
with defaults). Any new countries on the CD will also be installed for you. 
 

3)  Perform a FULL EzCoin installation & REMOVE ALL Application & 
Country files. 
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This is a complete NEW install and will DELETE ALL country files (all your 
inventory data for all countries will be deleted) for ALL CD’s you have 
installed previously. There is NO way to recover from this option unless 

you have valid backups of all your data in a location SEPARATE from 
where the program is installed. As indicated before, be certain that you 
have backed up your data to a location other than where the program is 
installed. We recommend that you keep a backup of your data on 
external media such as flash drives/memory sticks or external hard 
drives. 
In essence, this is the same as performing an UNINSTALL and then a re-
install of the current CD. 
 

4)  Remove EzCoin from your PC 

 
This option will completely remove all traces of EzCoin from your system. 
EzCoin does not use Windows Add/Remove Programs from Control Panel 
to uninstall. EzCoin has its own uninstaller on the CD. 
Obviously, this option will DELETE ALL country files (all your data for all 
countries will be deleted) for ALL CD’s you have installed as well as 
delete the program from your system.  

 
The final step for a first time install will create desktop shortcuts for you as 
well as bring up the Read Me file with last minute notes that may not be 
available in the manuals. We suggest that you at a minimum read the readme 
file. You can also print it for a permanent record. 
 

How do I … 

Can I track multiple collections ( i.e. my wife & I have separate 
collections )?  
    YES. EzCoin allows you to Duplicate any database so that you can keep 
separate files for each member of your family. Just go to File, Country 
Datafile Utilities, Duplicate Country. You can also use this feature to keep 

track of your own multiple collections. Some collectors prefer to track their 
circulation & bullion coins in separate files. It all depends on you & how you 
collect. EzCoin gives you the flexibility & power to do what you want!  

Can I inventory countries that you do not have databases for right 
now? 
    YES. With EzCoin, you can create any new country or database that we 
currently do not have. Just go to File, New & create your new database. You 
can also create topical databases where no catalogs or databases exist. This is 
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built into EzCoin. EzCoin, also allows you to easily add your own images for 
these newly created databases. 
 

How Do I Add Coins Not listed in the Supplied Databases 
Saving Custom Varieties  

To save any coin under a custom variety, call up any supplied record and 
modify any of the 5 key fields to form a unique combination that doesn't 
currently exist OR just enter any new data in the 5 key fields. Then click the 
blue checkmark button to save the record. This will display a dialog window.  

 

You will be asked to confirm the record as a main variety or sub-variety, after 
which the record will now be marked as a custom type, even if it was based 
on pre-supplied data. If any pre-supplied data existed, it will now be treated 
as custom information and no longer associated with pre-supplied data 
updates from SoftPro  

 

Can I use my own images instead of the ones you supply?  

YES. EzCoin allows you to scan in your own images & link them up to the 

databases in several ways. You can override the images we supply & display 
YOUR scanned coins. You can also add images for coins not listed in EzCoin. 
There are no limits imposed by EzCoin.  
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You simply scan in your images & save them in each country's sub folder. This 
is explained in detail in the manual.  We have developed an Image Editing 
program (EzImage) that is specifically designed for coin collectors. It is very 

user friendly & works with EzCoin.  

 


